KEYWORDS SEARCHING ALL JOBS:
A TOOL FOR AUTOMATICALLY RETRIEVING JOB
INFORMATION FROM WEB SERVERS

Technical Report 95-11

Qinmei Chen
Department of Computer Science and Engineering
Auburn University
Auburn University, Alabama 36849-5347

December 4, 1995
REPORT ABSTRACT

KEYWORDS SEARCHING ALL JOBS:

A TOOL FOR AUTOMATICALLY RETRIEVING JOB INFORMATION
FROM WEB SERVERS

Qinmei Chen

Master of Science, December 4, 1995

90 Typed Pages

Directed by W. Homer Carlisle, III

The objective of this project is to design and implement a PC Web client program called Keywords Searching All Jobs, which is a tool that can be used to automatically retrieve job information from Web servers. The program is developed by using the professional version Visual Basic 3.0, and TCP/IP communication custom control software called IPPort. The client program runs on MS Windows 3.1 or Windows 95 with a Winsock 1.1 compliant TCP/IP subsystem.

The principle function of the program is to provide the user with a tool to perform keyword search for jobs from Web servers, and automatically download the job information. A manual search involves the selection of a searching site, description of searching keywords, communication with the remote host, and storage of job information.
The program automates these tasks as well as provides a bookmark utility so that the user can repeatedly query Web sites.
TABLE OF CONTENTS

LIST OF TABLES ................................................................. v
LIST OF FIGURES ................................................................. vi

I. INTRODUCTION ................................................................. 1
   Problem
   Research Objective

II. DESIGN ................................................................. 3
   Main Operations
   Other Features

III. IMPLEMENTATION ................................................................. 10
   Internet Communications

IV. SAMPLES ................................................................. 17

V. CONCLUSIONS ................................................................. 29

VI. PLANNED CHANGES ................................................................. 30

VII. APPENDIX ................................................................. 31

A. Listing of the Program’s Text Forms
B. Listing of the Program’s Source Code
C. Listing of the Retrieved Job Information
LIST OF TABLES

1. The Code of GetSearchItem Sub Procedure ........................................ 12
2. The Code of IPPort1_DataIn Procedure ........................................ 13
3. The Code of IPPort1_Disconnected Procedure .................................. 14
4. The Code of Timer1_Timer Procedure ............................................ 16
5. The Required Files List of the Program ........................................... 17
LIST OF FIGURES

1. Main Form of the keywords Searching All Jobs Tool .......... 4
2. A Form for Adding a New Searching Site .................... 6
3. A Form for Deleting Searching Sites .......................... 8
4. A Form for File Options ....................................... 9
5. Running the Keywords Searching All Jobs Program ............ 18
6. The Program Works on Searching Jobs .......................... 19
7. Reading the Job Information .................................... 20
8. Reading the Help on Multiple Keywords ....................... 21
9. Adding a New Searching Site ................................... 22
10. Reading the Help on Adding a Searching Site ................ 23
11. Deleting Searching Sites ...................................... 24
12. Specifying the File Options ................................... 25
13. One Searching Site with Two Different Searching Keywords 26
15. Reading the About Message Box ............................... 28
I. INTRODUCTION

Problem

In the days of an information superhighway, an electronic job hunt has become an alternative way to search for jobs. More and more job searching servers have been made available on the Internet. People can easily get his/her specific job information by browsing the servers’ home pages and specifying searching requirements. But to obtain this on-line job information, people must wait for the information download from the remote host, and then wait to print out this information. For user convenience, a tool was designed and developed to make it possible for people to read job information off-line and print it out quickly. This tool is especially useful for the on-campus graduating student because they can use computers in the public PC labs to download the required job information, print it out, then read somewhere else.

Research Objective

The tool that was developed is a PC Web client program called Keywords Searching All Jobs, which can be used to automatically retrieve job information from Web servers. The principle function of the program that was written involves the selection of a searching site, description of searching keywords, communication with the remote host, and storage of retrieved job information. The program also provides a bookmark utility so that the user can easily query preferred sites.
The program was developed utilizing professional version Visual Basic 3.0, a powerful visual programming package for software development in the Microsoft Windows environment. The Internet communication functions of the program were implemented through a custom control software package called IPPort, which facilitates TCP/IP communications and provides an easy interface to Winsock functions. The developed tool runs on the system of MS Windows 3.1 or Windows 95 with a Winsock 1.1 compliant TCP/IP subsystem.
II. DESIGN

This chapter will explore the concept design of the Web client program. It is organized into two sections. They are:

1) The main operations of the Keywords Searching All Jobs tool;
2) Other features of the tool.

Main Operations

The main operations of the tool are the selection of a searching site, description of searching keywords, communication with the remote host, and storage of retrieved job information. Information is required of the user to support these operations, and to obtain this information, a main form has been designed as shown in Figure 1.

The main form operations are divided into three groups. In the top panel box, there is a combo list box to hold the available searching sites in a way that the user can easily select one site from the list. In addition, there is a text box to let the user specify the searching keywords that will be used in the job search query. Users may need assistance in understanding issues such as entering multiple keywords since often he/she may need to follow some specific patterns. The nearby Help button provides this assistance. In the second panel, there is a text box to allow the user specify the file path and name of the file to store the retrieved job information. To reduce typing and therefore reduce typing error, a Browse button is available to provider the user with the standard “save as” file dialog box to specify the file path. The final grouping on the main form is three function buttons.
The Commit button is designed to start the Internet communication session, whereas the Stop button shuts down a communication session. The Exit button exits the application. The other controls in this panel will be discussed in Chapter III.

Figure 1. Main Form of the Keywords Searching All Jobs Tool
Since the process of searching jobs and downloading job information takes a few minutes, and most of the TCP/IP calls in the program are designed to be asynchronous, the design makes it possible for the user to do something else with the screen while waiting for results. The application window is designed to automatically shrink into a small logo icon so that the user will have a neat desktop. To provide feedback during this time, the caption of the icon is used for this purpose, and changed during the processing session. While searching, the prompt is “Working on Job Searching”. After searching, the caption changes to “Retrieving x Matched Job Information”. Here x is the number of job items that matches the searching query. While downloading information, the prompt will be “Retrieving y of x Matched Job Information”. Here y is the current index of the job items. In the case of a large x, the user can stop the process at any point by clicking on the Stop button. When the program has finished downloading information, the prompt is changed to “Job Searching Done! x Matched Jobs.”. To start another searching session, the user click on the logo icon, and the program window will be restored. To exit the application, the user can either click on the Exit button or use the standard Windows Exit menu, or system menu Close. To view the job information, the user may open a text viewer, such as the Windows Notepad, or any word processor to read or print the information. A possible extension to this tool would be to provide a button to support this operation.
Other Features

The application has a simple and standard menu bar which contains two feature functions. One is a bookmark utility that manages the existing searching sites; the other is the options menu that allow the user to alter program setup. An external text file SiteDB.dat is used to record the bookmark. This file is easily read and written with a text viewer, such as the Windows Notepad, or any text processor.

To add a new searching site, the user will click on the **Bookmark -> Add site ...** menu. The form for this operation that was designed is shown in Figure 2.

![Figure 2. A Form for Adding a New Searching Site](image-url)
In the form of Figure 2, the host title is the name for a searching site, which will appear on the site list of the main form. Either the remote host name or address, and the port number are required to connect to the host. The default Web protocol port number 80 is provided in the text box. The searching database is the database file name that will operate searching queries. The searching keywords are optional. If entered, it is best to put the most frequently used keywords that are associated with searches. The keywords can be easily changed in the main form by clicking on the Save Keywords button. To confirm an addition, the user needs to click on the Apply button, and the Cancel button ignores any change. As a guide to this, the Help button is provided.

To delete existing searching sites, the user can click on the Bookmark -> Delete Sites... menu. The form for this operation is designed shown in Figure 3.
In the form illustrated in Figure 3, there is a list box which shows all the existing searching sites. The list box supports multiple selections so that the user can delete multiple sites at once. When the user clicks the **Delete** button after selecting sites, a message box pops up to request a confirmation of the pending deletion.

The **Options -> File Options** ... menu allows the user to change the default file path for the external searching sites file and the file for saving the results of a query. The form associated with this operation is designed as shown in Figure 4.
The default file paths for these two files are the directory of the program's executable file. The file names that are created are SiteDB.dat and JobData.dat.
III. IMPLEMENTATION

The complete source code of the program is listed in the appendixes, but this chapter examines in detail the code that provides for Internet communications which is the key operation of the program.

Internet Communications

The Internet communications implemented in this program is through a shareware product called IPPort, which is software that facilitates TCP/IP communications by providing an easy interface to Winsock functions. This product is from DevSoft (http://www.dev-soft.com/devsoft).

As illustrated in Figure 1, there is a socket control object on the main form near the Exit button. This control has a minimum of properties, and four events: Connected, ReadyToSend, DataIn, and Disconnected. The events are relatively self-explanatory. To support these events in code, a connection is attempted by setting the Connected property to True, and then waiting for the Connected event. The remote host is defined by setting the Port property and either the HostName or the HostAddress property. Data is sent by assigning the data string to the DataToSend property. The operation of the control is almost completely asynchronous. All the calls operate through Windows messages (no blocking calls), except for the ones that deal with host name and address resolution. The gain in performance is considerable when compared to using blocking calls.
In the program, a searching session can be divided into two tasks. The first task is to send a query and retrieve the matched job indexes. Based on the retrieved job indexes, the second task is to download automatically the matched job information. When the user clicks on the Commit button, the CommitBtn_Click event is triggered to start the initial job searching task. Within this event, the call to a GetSearchItem Sub procedure begins the TCP/IP communication. The call is:

```
call GetSearchItem (formKeyword, "Key")
```

with the active parameters being the encoded keywords and Key query protocol. The GetSearchItem Sub code is listed in Table 1.

After establishing a connection to the remote host, the program sends a searching string to the DataToSend property of the IPProt1 control. The searching string starts with the GET command. The GET command is the most frequently used command within the hypertext transfer protocol (HTTP). This command can defines the communication of a cgi-program running on the Web server and a client program form. Provided with the GET command will be the search document name and search terms to the server with the Key protocol.
Table 1. The Code of GetSearchItem Sub Procedure

Sub GetSearchItem (searchkey As String, operation As String)

    On Error GoTo ErrorHandling:

    iport1.EOL = Chr$(10)

    'close old connection - if any
    iport1.Connected = False

    If HostOption = "HostName" Then
        iport1.HostName = HostName
        If StrComp(HostName, "www.occ.com", 1) <> 0 Then
            MsgBox "This searching site does not work. Please try the site: Online Career Center!", 16, "Error"
            Exit Sub
        End If
    Else
        iport1.HostAddress = HostAddr
    End If

    iport1.Port = PortNumber

    'ask for connection
    iport1.Connected = True

    'wait until it is achieved
    Do Until iport1.Connected: DoEvents: Loop

    'send data
    OutputStart = False

    iport1.DataToSend = "GET " & DBSearchFile & ":and:" & operation & ":" & searchkey & Chr$(10)
    Exit Sub

    ErrorHandling:
        mainform.MousePointer = 0
        MsgBox "Error!! " & Error$
        iport1.Connected = False
        Exit Sub

End Sub
When the data is transfer from the host, the **IPPort1_DataIn** event is executed.

The code of the event is listed below.

Table 2. The Code of **IPPort1_DataIn** Procedure

```vbnet
Sub IPPort1_DataIn (Text As String, EOL As Integer)

 'filter empty line
 If StrComp(Text, "") = 0 Then
   Exit Sub
 End If

 If OutputStart Then 'start to download
   If Not searchdone Then 'keyword searching
     Open TempFileName For Append As #1
     Write #1, Text
     Close #1
   Else 'item searching
     Open DataFileName For Append As #1
     Write #1, Text
     Close #1
   End If
 End If

 'set download to start
 If (InStr(Text, "<center>") <> 0) And (OutputStart = False) Then
   OutputStart = True
 End If

End Sub
```

In this event, a boolean variable **OutputStart** is used to control when to start download because the downloaded information is hypertext which contains some markup code that will be of no use in this program. The retrieved information is temporally stored in an external file.

After receiving all data, the Internet connection will be automatically closed so that the **IPPort1_Disconnected** event is triggered. The code of the event is listed in Table 3.
Sub IPPort1_Disconnected (Statuscode As Integer, Description As String)
    If Description <> "OK" Then
        MsgBox "Connection broken: " & Description
    End If

    'keyword searching done, parse tempfile to search job items
    If Not searchdone = True Then
        searchdone = True
        Searchindex = 0
        FilterTempFile (TempFileName)
        writeHeader "write header on the output file
        mainform.Caption = "Retrieving " & TotalSearchItem & " Matched Job Information." " change caption
    End If

    If searchdone Then 'keyword search done
        If NoMatch Then
            mainform.MousePointer = 0 'set mousepointer to normal
            If mainform.WindowState = 1 Then
                mainform.Caption = "Job Searching done. No matches!" 'if window is minimized
            End If
            If Len(Dir$(TempFileName)) > 0 Then
                Kill TempFileName
            End If
            Timer1.Enabled = False
            SearchFinished = True 'one session searching done
            Exit Sub
        End If

        If Searchindex = TotalSearchItem Then 'item search done
            mainform.MousePointer = 0 'set mousepointer to normal
            If mainform.WindowState = 1 Then
                mainform.Caption = "Job Searching done. " & TotalSearchItem & " matched job items."
            Else
                mainform.Caption = "Keywords Searching All Jobs" 'if window is normal size
            End If
            If Len(Dir$(TempFileName)) > 0 Then
                Kill TempFileName
            End If
            SearchFinished = True 'one session searching done
        Else
            Searchindex = Searchindex + 1 'count item index
            doSearchItem = True 'start searching item
            writeSubHeader (Searchindex)
            mainform.Caption = "Retrieving " & Searchindex & " of " & TotalSearchItem & " Matched job items."
        End If
    End If
End Sub
In this disconnected event, the number of connections is counted with the first connection being search task. After the first connection, the program parses the downloaded information which is saved in an external temporary file. After parsing information, the program will start the second searching connection to download sequentially the matched job information.

If the data is sent to the remote host faster than it can process it, or faster than the network bandwidth allows, the outgoing queue will fill up. When this happens, the **DataToSent** event fails with error. To have a stable performance, the program uses the strategy not sending the data until the previous connection has been disconnected. A timer control object that is shown in the main form is used in the program to monitor the process. The **Timer1_Timer** event is triggered at every specified time interval. The code to handle the event is listed in Table 4.

In the event, when a previous job’s retrieving is finished, the timer sends the next searching string to the remote host. Since the second connection of the program is to retrieve information, instead of searching information, the GET command protocol is **Get**. After downloading all the job items, the **Enabled** property of the Timer1 is set to False, which stops the timer.
Table 4. The Code of Timer1 Timer Procedure

Sub Timer1_Timer ()

' if ready to search item, then link to the host, and send request
If (searchdone And dosearchitem) Then
    Call GetSearchItem(SearchItems(Searchindex), "get")
    dosearchitem = False
End If

' after finish item search, stop the timer
If Searchindex = TotalSearchItem Then
    Timer1.Enabled = False
End If

End Sub
IV. SAMPLES

The program of this project research runs on a PC with the system of MS Windows 3.1 or Windows 95, and a Winsock 1.1 compliant TCP/IP subsystem, such as Trumpet Winsock, and TwinSock. The files required for this program are listed in Table 5.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReadMe.txt</td>
<td>A file to describe the tool</td>
</tr>
<tr>
<td>JobHunt.exe</td>
<td>An executable file to run this tool</td>
</tr>
<tr>
<td>IPPort.vbx</td>
<td>A TCP/IP communication custom control</td>
</tr>
<tr>
<td>IPPort.lic</td>
<td>A license to use the IPPort custom control</td>
</tr>
<tr>
<td>Threed.vbx</td>
<td>3D controls which are three-dimensional counterparts to standard Visual basic controls</td>
</tr>
<tr>
<td>CMDDialog.vbx</td>
<td>Common dialog box controls</td>
</tr>
<tr>
<td>SiteDB.dat</td>
<td>An external file to store the searching sites. By default, it is in the same directory as the JobHunt.exe file</td>
</tr>
<tr>
<td>Options.dat</td>
<td>An external file to specify the file path of SiteDB.dat, and the file name to save the retrieved job information. It should be in the same directory as the JobHunt.exe file</td>
</tr>
<tr>
<td>vbrun300.dll</td>
<td>A dynamic link library to run Visual Basic 3.0 applications. It should be copyed to the Windows\System directory</td>
</tr>
</tbody>
</table>

You can run the program either from a floppy drive or a hard drive. In the former case, you may open the file manager program, then double click on the a:\JobHunt.exe file name; or in the program manager, click the File -> Run ... menu and type the file name. In the latter case, the user can create a directory called JobHunt, then copy the
required files into the JobHunt directory. The user may also create a program icon for this tool in the Windows program manager and click on the icon to start the program.

The sample session in this chapter is running on the system of Windows 95 with Twinsock 1.4. When started, the main form of the program is as shown in Figure 5.

Figure 5. Running the Keywords Searching ALL Jobs Program
On this main form, the user selects a searching site by clicking on one of the site list and specifying a new searching keyword if needed. To define the file path for the file to store the retrieved job information, the user can click on the **Browse...** button. A standard "save as" file dialog box will pop up to help the user to enter the correct file path. After the user click the **OK** button, the specified file path will show on the file path box. Then a click on the **Commit** button begins the search. The program window will then shrink into a small icon on the desktop as shown in Figure 6, and the title of the file icon will be changed from "Keywords Searching All Jobs" to "Working on Job Searching".

**Figure 6.** The Program Works on Searching Jobs
As shown in Figure 5, the “Online Career Center” searching site is selected. It is the Internet’s first and most frequently accessed career center. The searching keywords are “chemical unix c++” to find job openings mentioning chemical, UNIX, and C++ skills.

When the searching is completed, the title of the file icon is changed into “Job Searching Done. 5 Matched Job Items.”. The user can open the job data file with the Windows Notepad program or any other text viewer to read or print the retrieved job information. Figure 7 shows the WinPad program being used to read the information. The printout of the retrieved job information is listed in the appendix.

Figure 7. Reading the Job Information
To begin another keywords search, the user can double click on the file icon. The program then restores its normal window size, the window title is changed back to "Keywords Searching All Jobs", and the user can then select another searching site, and specify other keywords or file path. To exit the application, the user can click on the Exit button in the main form or click on the File -> Exit menu, or close the icon directly.

Since the search program uses boolean logic to operate with multiple keywords, the user must follow the specific patterns to enter multiple keywords. A Help button provides help information as shown in Figure 8.

Figure 8. Reading the Help on Multiple Keywords
To use the bookmark utility, the user selects the **Bookmark -> Add list...** menu item. A form as shown in Figure 9 will pop up. In this form, the user fills in the six entry boxes with the remote host information. This utility is designed for the user who is familiar with the Web protocols. For the beginners, this information can be provided in a default file. For example, to enter the Online Career Center site, the user fills the form as shown in Figure 9, then click on the **Apply** button to update the external searching sites file and the site list on the main form. The **Help** button on this form is designed to guide the user in filling out the form. The help information window shown in Figure 10.

![Figure 9. Adding a New Searching Site](image)
To delete the existing search sites, the user may click on the **Bookmark -> Delete** list..., producing a form as shown in Figure 11. In this form, a list box contains all the existing search sites. the user can select one or more sites to delete, then click on the **Delete** button. To be safe, a message box will pop up requesting that the user confirm the deletion. If confirmed, the external searching sites file and the site list on the main form will be updated.
The Options -> File Options... menu allows the user to change the default file path of the external searching sites file and the file used to store the retrieved job information. The form is shown in Figure 12, and the OK button updates the Options.dat file.
Figure 12. Specifying the File Options

For each search site, the user can easily change the searching keywords based on his/her needs. Keywords can be saved for next use by clicking on the **Save Keywords** button. The external searching sites file will be updated. Any text editor can be used to associate several searching keywords with one searching site by editing the searching sites file. The user can copy the same information of a site, only change the keywords. As shown in figure 13, The Online Career Center site has been given two searching keywords.
Figure 13. One Searching Site with Two Different Searching Keywords
To reduce typing, the **Browse...** button helps the user specify the file path to store the retrieved information. The standard "Save As" file dialog box is shown in Figure 14.

![Figure 14. Specifying the File Path to Store the Retrieved Job Information](image)
Suggestions or bugs can be reported to the author by selecting the Help -> About menu. Figure 15 shows the information provided by this pop-up window.

![Screenshot of a pop-up window](image)

Figure 15. Reading the About Message Box
V. CONCLUSIONS

The program developed in this research has the following benefits:

1) Keywords searching for jobs on the Web;

2) Automatic retrieving job information from Web servers;

3) Easy and fast accessing to Web job searching servers;

4) Highly interactive user interfaces;

5) Convenient use of the bookmark utility.
VI. PLANNED CHANGES

So far, only one searching site has been chosen for this tool. It is the Internet's first and most frequently accessed career center-- Online Career Center. Other sites can be added.

Other improvements would be to permit the user run the program in various ways. For example, the Run Options could allow the user to run the program on selected days, or let the user specify the best time to run the program. The Timer Options will let the user specify the interval property of the timer control based on the Internet communication speed the system has.

Another advanced feature would be to allow the user to write scripts that run the program to search several sites in one session.
APPENDIX A

Listing of the Program's Text Forms
MAINFORM.FRM - 1

VERSION 2.00
Begin Form mainform
BackColor = &H00808080&
BorderStyle = 3 'Fixed Double
Caption = "Keywords Searching All Jobs"
ClientHeight = 4275
ClientLeft = 2055
ClientTop = 2070
ClientWidth = 6465
Height = 4965
Icon = (Icon)
Left = 1995
LinkTopic = "Form1"
ScaleHeight = 4275
ScaleWidth = 6465
Top = 1440
Width = 6585
Begin SSCcommand StopBtn
  Caption = "Stop"
  Height = 495
  Left = 1920
  Picture = (none)
  TabIndex = 13
  Top = 3600
  Width = 1215
End
Begin IPPORT IPPort1
  EOL = "\n"
  InBufferSize = 2048
  Left = 4320
  LocalPort = 0
  OutBufferSize = 2048
  Port = 0
  Top = 3600
End
Begin CommonDialog FileSaveDialog
  Left = 3720
  Top = 3600
End
Begin Timer Timer1
  Interval = 20000
  Left = 3240
  Top = 3600
End
Begin SSCcommand ExitBtn
  Caption = "Exit"
  Height = 495
  Left = 4920
  Picture = (none)
  TabIndex = 7
  Top = 3600
  Width = 1215
End
Begin SSCcommand CommitBtn
  Caption = "Commit"
  Height = 495
  Left = 240
  Picture = (none)
  TabIndex = 6
  Top = 3600
  Width = 1215
End
Begin SSSPanel Panel3D2
   BevelInner = 1 'Inset
   Height = 1215
   Left = 240
   TabIndex = 11
   Top = 2280
   Width = 5895
Begin SSSCommand BrowseBtn
   Caption = "Browse..."
   Height = 375
   Left = 4200
   Picture = (none)
   TabIndex = 5
   Top = 600
   Width = 1455
End
Begin TextBox FileNameBox
   Height = 285
   Left = 2520
   TabIndex = 4
   Top = 240
   Width = 3135
End
Begin Label Label3
   BackStyle = 0 'Transparent
   Caption = "Save Job Information as:
   Height = 255
   Left = 120
   TabIndex = 12
   Top = 240
   Width = 2295
End
End
Begin SSSPanel Panel3D1
   BevelInner = 1 'Inset
   Caption = " "
   Height = 1815
   Left = 240
   TabIndex = 8
   Top = 240
   Width = 5895
Begin SSSCommand SaveKeyBtn
   Caption = "Save Keyword"
   Height = 375
   Left = 2520
   Picture = (none)
   TabIndex = 2
   Top = 1200
   Width = 1455
End
Begin SSSCommand HelpBtn
   Caption = "Help"
   Height = 375
   Left = 4200
   Picture = (none)
   TabIndex = 3
   Top = 1200
   Width = 1455
End
Begin TextBox KeywordBox
MAINFORM.FRM - 3

Height = 285
Left = 2520
TabIndex = 1
Top = 840
Width = 3135
End

Begin ComboBox SiteCombo
Height = 315
Left = 2520
Style = 2 'Dropdown List
TabIndex = 0
Top = 240
Width = 3135
End

Begin Label Label2
BackStyle = 0 'Transparent
Caption = "Enter Searching Keyword:"
Height = 255
Left = 240
TabIndex = 10
Top = 840
Width = 2295
End

Begin Label Label1
BackStyle = 0 'Transparent
Caption = "Select Searching Site:"
Height = 255
Left = 240
TabIndex = 9
Top = 240
Width = 2055
End

End

Begin Menu mnuFile
Caption = "&File"
Begin Menu mnuExit
Caption = "&Exit"
End

End

Begin Menu mnuBookmark
Caption = "&Bookmark"
Begin Menu mnuAddSite
Caption = "&Add Site..."
End
Begin Menu mnuDeleteSite
Caption = "&Delete Site..."
End

End

Begin Menu mnuOption
Caption = "&Options"
Begin Menu mnuFileOpt
Caption = "&File Options..."
End
Begin Menu mnuSaveOpt
Caption = "&Save Options"
End

End

Begin Menu mnuHelp
Caption = "&Help"
Begin Menu mnuAbout
Caption = "&About..."
VERSION 2.00
Begin Form AddSiteForm
  BackColor = &H00808080&
  BorderStyle = 3 'Fixed Double
  Caption = "Add Job Searching Site"
  ClientHeight = 4875
  ClientLeft = 2040
  ClientTop = 1770
  ClientWidth = 5760
  Height = 5280
  Left = 1980
  LinkTopic = "Form1"
  ScaleHeight = 4875
  ScaleWidth = 5760
  Top = 1425
  Width = 5880
Begin SSCommand HelpBtn
  Caption = "Help"
  Height = 495
  Left = 4200
  Picture = (none)
  TabIndex = 10
  Top = 4080
  Width = 1215
End
Begin SSCommand CancelBtn
  Caption = "Cancel"
  Height = 495
  Left = 2160
  Picture = (none)
  TabIndex = 9
  Top = 4080
  Width = 1215
End
Begin SSCommand ApplyBtn
  Caption = "Apply"
  Height = 495
  Left = 360
  Picture = (none)
  TabIndex = 8
  Top = 4080
  Width = 1215
End
Begin SSSPanel Panel3D1
  BevelInner = 1 'Inset
  Height = 3255
  Left = 360
  TabIndex = 11
  Top = 360
  Width = 5055
Begin TextBox HostTitleBox
  Height = 285
  Left = 1920
  TabIndex = 0
  Top = 360
  Width = 2775
End
Begin TextBox KeywordBox
  Height = 285
  Left = 2280
  TabIndex = 7
ADDSITE.FRM - 2

Top = 2640
Width = 2415
End

Begin TextBox DBBox
  Height = 285
  Left = 2280
  TabIndex = 6
  Top = 2160
  Width = 2415
End

Begin TextBox PortNumbBox
  Height = 285
  Left = 1920
  TabIndex = 5
  Text = "80"
  Top = 1680
  Width = 2775
End

Begin SSOption HostAddrOpt
  Caption = "Host Address:"
  Height = 255
  Left = 360
  TabIndex = 3
  TabStop = 0 'False
  Top = 1200
  Width = 1455
End

Begin SSOption HostNameOpt
  Caption = "Host Name:"
  Height = 255
  Left = 360
  TabIndex = 1
  Top = 720
  Value = -1 'True
  Width = 1335
End

Begin TextBox HostAddrBox
  Height = 285
  Left = 1920
  TabIndex = 4
  Top = 1200
  Width = 2775
End

Begin TextBox HostNameBox
  Height = 285
  Left = 1920
  TabIndex = 2
  Top = 720
  Width = 2775
End

Begin Label Label1
  BackStyle = 0 'Transparent
  Caption = "Host Title:"
  Height = 255
  Left = 360
  TabIndex = 15
  Top = 360
  Width = 1455
End

Begin Label Label5
  BackStyle = 0 'Transparent
Caption = "Searching Database:
Height = 255
Left = 360
TabIndex = 14
Top = 2160
Width = 1935
End
Begin Label Label4
BackStyle = 0 'Transparent
Caption = "Searching Keywords:"
Height = 255
Left = 360
TabIndex = 13
Top = 2640
Width = 1815
End
Begin Label Label3
BackStyle = 0 'Transparent
Caption = "Port Number:"
Height = 255
Left = 360
TabIndex = 12
Top = 1680
Width = 1455
End
End
DELSITE.FRM - 1

VERSION 2.00

Begin Form DelSiteForm
   BackColor = &H00808080&
   BorderStyle = 3 'Fixed Double
   Caption = "Delete Job Searching Site"
   ClientHeight = 3990
   ClientLeft = 3255
   ClientTop = 1980
   ClientWidth = 3555
   Height = 4395
   Left = 3195
   LinkTopic = "Form2"
   ScaleHeight = 3990
   ScaleWidth = 3555
   Top = 1635
   Width = 3675

Begin SCommand CancelBtn
   Caption = "Cancel"
   Height = 495
   Left = 2040
   Picture = (none)
   TabIndex = 3
   Top = 3240
   Width = 1215

End

Begin SCommand DelBtn
   Caption = "Delete"
   Height = 495
   Left = 240
   Picture = (none)
   TabIndex = 2
   Top = 3240
   Width = 1215

End

Begin ListBox SiteList
   Height = 2565
   Left = 240
   MultiSelect = 1 'Simple
   Sorted = -1 'True
   TabIndex = 0
   Top = 480
   Width = 3015

End

Begin Label Label1
   BackStyle = 0 'Transparent
   Caption = "Select Sites to Delete:"
   Height = 255
   Left = 240
   TabIndex = 1
   Top = 120
   Width = 2295

End

End
FILEOPT.FRM - 1

VERSION 2.00
Begin Form FileOptForm
  BackColor = &H00808080&
  BorderStyle = 3 'Fixed Double
  Caption = "File Options"
  ClientHeight = 3045
  ClientLeft = 2025
  ClientTop = 2310
  ClientWidth = 5820
  Height = 3450
  Left = 1965
  LinkTopic = "Form1"
  ScaleHeight = 3045
  ScaleWidth = 5820
  Top = 1965
  Width = 5940
Begin SCommand CancelBtn
  Caption = "Cancel"
  Height = 495
  Left = 3840
  Picture = (none)
  TabIndex = 4
  Top = 2160
  Width = 1215
End
Begin SCommand OKBtn
  Caption = "OK"
  Height = 495
  Left = 600
  Picture = (none)
  TabIndex = 3
  Top = 2160
  Width = 1215
End
Begin SPanel Panel3D1
  BevelInner = 1 'Inset
  Height = 1455
  Left = 360
  TabIndex = 0
  Top = 360
  Width = 5055
Begin TextBox JobDataBox
  Height = 285
  Left = 2520
  TabIndex = 2
  Top = 840
  Width = 2175
End
Begin TextBox SiteDBBox
  Height = 285
  Left = 2520
  TabIndex = 1
  Top = 360
  Width = 2175
End
Begin Label Label2
  BackStyle = 0 'Transparent
  Caption = "Job Information File Path:"
  Height = 255
  Left = 240
  TabIndex = 6
FILEOPT.FRM - 2

    Top      =  840
    Width    =  2295
End

Begin Label Label1
    BackStyle  =  0  'Transparent
    Caption    =  "Searching Site File Path:"
    Height     =  255
    Left       =  240
    TabIndex   =  5
    Top        =  360
    Width      =  2175
End
End
End
VERSION 2.00

Begin Form KeyHelpForm
  BackColor = &H00808080&
  BorderStyle = 3 'Fixed Double
  Caption = "Help on Entering Job Searching Keyword"
  ClientHeight = 4215
  ClientLeft = 1890
  ClientTop = 1935
  ClientWidth = 6585
  Height = 4620
  Left = 1830
  LinkTopic = "Forms"
  ScaleHeight = 4215
  ScaleWidth = 6585
  Top = 1590
  Width = 6705
End

Begin SSCommand OKBtn
  Caption = "OK"
  Height = 495
  Left = 2640
  Picture = (none)
  TabIndex = 1
  Top = 3600
  Width = 1215
End

Begin SSPanel Panel3D1
  BevelInner = 1 'Inset
  Height = 3135
  Left = 360
  TabIndex = 0
  Top = 240
  Width = 5895
End

Begin Label Label6
  BackStyle = 0 'Transparent
  Caption = "unix or sybase jobs with EITHER unix OR sy
  Height = 255
  Left = 840
  TabIndex = 7
  Top = 2520
  Width = 4815
End

Begin Label Label5
  BackStyle = 0 'Transparent
  Caption = "unix and sybase jobs with BOTH unix AND sybas
  Height = 255
  Left = 840
  TabIndex = 6
  Top = 2160
  Width = 4695
End

Begin Label Label4
  BackStyle = 0 'Transparent
  Caption = "unix sybase jobs with BOTH unix AND syb
  Height = 255
  Left = 840
  TabIndex = 5
  Top = 1800
  Width = 4695
End

Begin Label Label3
  BackStyle = 0 'Transparent
<table>
<thead>
<tr>
<th>Caption</th>
<th>&quot;KEYWORD(s) SEARCH RESULTS&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>255</td>
</tr>
<tr>
<td>Left</td>
<td>840</td>
</tr>
<tr>
<td>TabIndex</td>
<td>4</td>
</tr>
<tr>
<td>Top</td>
<td>1440</td>
</tr>
<tr>
<td>Width</td>
<td>4455</td>
</tr>
</tbody>
</table>

End

Begin Label Label2

| BackStyle       | 0 'Transparent             |
| Caption         | "The search program uses boolean logic. For example |
| Height          | 375                         |
| Left            | 480                         |
| TabIndex        | 3                           |
| Top             | 960                         |
| Width           | 3495                        |

End

Begin Label Label1

| BackStyle       | 0 'Transparent             |
| Caption         | "Since job titles vary, always search job listings |
| Height          | 495                         |
| Left            | 480                         |
| TabIndex        | 2                           |
| Top             | 360                         |
| Width           | 4215                        |

End

End
HELPFORM.FRM - 1

VERSION 2.00
Begin Form HelpForm
BackColor = &H00808080&
BorderStyle = 3 'Fixed Double
Caption = "Help On Adding Job Searching Site"
ClientHeight = 4425
ClientLeft = 1890
ClientTop = 1950
ClientWidth = 6345
Height = 4830
Left = 1830
LinkTopic = "Form4"
ScaleHeight = 4425
ScaleWidth = 6345
Top = 1605
Width = 6465
Begin SSCommand OKBtn
  Caption = "OK"
  Height = 495
  Left = 2400
  Picture = (none)
  TabIndex = 1
  Top = 3720
  Width = 1215
End
Begin SSPanel Panel3D1
  BevelInner = 1 'Inset
  Height = 3255
  Left = 360
  TabIndex = 0
  Top = 240
  Width = 5535
Begin Label Label5
  BackStyle = 0 'Transparent
  Caption = "Searching Keywords are the most frequently used ke
  Height = 495
  Left = 240
  TabIndex = 6
  Top = 2520
  Width = 5175
End
Begin Label Label4
  BackStyle = 0 'Transparent
  Caption = "Port number specifies the communication channel. T
  Height = 375
  Left = 240
  TabIndex = 2
  Top = 1200
  Width = 4575
End
Begin Label Label3
  BackStyle = 0 'Transparent
  Caption = "Host name or address identifies the remote host."
  Height = 375
  Left = 240
  TabIndex = 5
  Top = 720
  Width = 4935
End
Begin Label Label2
  BackStyle = 0 'Transparent
HELPFORM.FRM - 2

Caption = "Host title specifies a unique title for each search"
Height = 375
Left = 240
TabIndex = 4
Top = 240
Width = 5175

End
Begin Label Label1
BackStyle = 0 'Transparent
Caption = "Searching database file is the database to accept"
Height = 375
Left = 240
TabIndex = 3
Top = 1920
Width = 4935

End
End
End
**ABOUT.FRM - 2**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>4095</td>
</tr>
</tbody>
</table>

End

**Begin Label Label2**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BackStyle</td>
<td>0</td>
</tr>
<tr>
<td>Caption</td>
<td>&quot;This Program was developed by Qinmei Chen. All cop</td>
</tr>
<tr>
<td>Height</td>
<td>495</td>
</tr>
<tr>
<td>Left</td>
<td>360</td>
</tr>
<tr>
<td>TabIndex</td>
<td>3</td>
</tr>
<tr>
<td>Top</td>
<td>960</td>
</tr>
<tr>
<td>Width</td>
<td>4095</td>
</tr>
</tbody>
</table>

End

**Begin Label Label1**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BackStyle</td>
<td>0</td>
</tr>
<tr>
<td>Caption</td>
<td>&quot;Keywords Searching All Jobs Version 1.0&quot;</td>
</tr>
<tr>
<td>Height</td>
<td>375</td>
</tr>
<tr>
<td>Left</td>
<td>360</td>
</tr>
<tr>
<td>TabIndex</td>
<td>2</td>
</tr>
<tr>
<td>Top</td>
<td>480</td>
</tr>
<tr>
<td>Width</td>
<td>3975</td>
</tr>
</tbody>
</table>

End
APPENDIX B

Listing of the Program's Source Code
JOBHUNT.BAS - 1

Option Explicit

'set the default external file names
Global Const OptionFileName = "e:\code\jobhunt\options.dat"
Global Const TempFileName = "e:\code\jobhunt\tempfill.dat"

declare the variables for linking to the remote host
Global HostTitle As String "HostName" or "HostAdrr"
Global HostOption As String
Global HostName As String
Global HostAddr As String
Global PortNumber As String
Global DBSearchFile As String 'the searching database file name
Global Keyword As String 'searching keyword
Global DBSiteFile As String 'the external file name to hold the searching sites
Global DBSiteBackFile As String 'the external file name to back up the searching sites
Global DataFileName As String 'the external file name to hold the download job information
Global SiteDB() As String 'the internal data structure to hold the searching sites
Global NumberOfSites As Integer

'Global NumberOfItems As Integer 'number of the query matched
'Global TotalSearchItem As Integer 'number of the download items
'Global SearchIndex As Integer 'currently searching index
'Global SearchItems() As String 'the data structure to hold the job searching indexes

'Global SearchDone As Integer 'true: working on searching keyword; false: finished searching keyword
'Global OutputStart As Integer 'true: starting to download information from the host
'Global doscopearchitem As Integer 'true: working on search job information
'Global broken As Integer 'true: the input text is not completed
'Global brokenitem As String 'the incompeled part of the input text

Function GetPath (ByVal fullFileName$) As String
Dim s, x As Integer

s = 1

'find the position of "\"
For x = s To Len(fullFileName$)
  If StrComp(Mid$(fullFileName$, x, 1), "\") = 0 Then
    s = x
  End If
Next x

If s = 0 Then '"\" not found
  GetPath = fullFileName
Else
  GetPath = Mid$(fullFileName, 1, s - 1)
End If

End Function
JOBHUNT.BAS - 2

Sub LoadDBFile ()
    Dim x, y As Integer

    If Len(Dir(DBSiteFile)) > 0 Then
        mainform.SiteCombo.Clear
        Open DBSiteFile For Input As #1
        Input #1, NumberOfSites
        ReDim SiteDB(NumberOfSites, 6)
        For x = 1 To NumberOfSites
            For y = 1 To 6
                Input #1, SiteDB(x, y)
                If y = 1 Then
                    mainform.SiteCombo.AddItem SiteDB(x, y)
                End If
            Next y
        Next x
        mainform.SiteCombo.ListIndex = 0
        Close #1
    Else
        MsgBox "Cannot find the site database file! Please specify the file path in the Options menu.", 16, "Error"
    End If
End Sub

Sub LoadFileOptions ()
    If Len(Dir(OptionFileName)) > 0 Then
        Open OptionFileName For Input As #1
        Input #1, DBSiteFile
        Input #1, DataFileName
        Close #1
    Else
        MsgBox "Cannot find options.dat file! Please make sure the file is in your currently directory.", 16, "Error"
    End If
End Sub
Sub SaveFileOptions ()
    If Len(Dir(OptionFileName)) > 0 Then
        Open OptionFileName For Output As 
        Write 
        Write 
        Close 
    Else
        MsgBox "Cannot find the Options.dat file! Please make sure the file is in your currently directory."
    End If
End Sub
MAINFORM.FRM - 1

Option Explicit

Dim formfeed, linefeed As String

Dim numberOfItems As Integer 'number of the query matched
Dim TotalDownloadItem As Integer 'number of the download items
Dim SearchIndex As Integer 'currently searching index
Dim SearchItems() As String 'the data structure to hold the job searching indexes

Dim searchdone As Integer 'true: working on searching keyword; false: finish
Dim OutputStart As Integer 'true: starting to download information from the host
Dim dosearchitem As Integer 'true: working on search job information
Dim SearchFinished As Integer 'true: finished one session searching

Dim broken As Integer 'true: the input text is not completed
Dim brokenitem As Integer 'the incompleted part of the input text

Dim Header As String 'the header of teh output file
' Dim windowicon As Integer 'true: minimize;
Dim NoMatched As Integer 'true: returned no matched items

Sub closeOpenedfile()

Dim filenumber As Integer

filenumber = FreeFile
If filenumber = 2 Then
    Close #1
End If

End Sub

Sub FilterItems(ByVal tstr$, Items() As String, index As Integer)

'find "get:" key string
Do While Len(tstr$) > 0
    s1 = 1
    s2 = InStr(s1, tstr$, " ")
    If s2 <> 0 Then
        For y = s1 To s2
            If (StrComp(Mid$(tstr$, y, 1), "g") = 0) Then
                If (StrComp(Mid$(tstr$, y + 1, 1), "e") = 0) Then
                    If (StrComp(Mid$(tstr$, y + 2, 1), "t") = 0) Then
                        If (StrComp(Mid$(tstr$, y + 3, 1), ":") = 0) Then
                            s1 = y + 4
                            index = index + 1
                            SearchItems(index) = Mid$(tstr$, s1, s2 - 2 - s1)
                            s1 = s2
                        End If
                    End If
                End If
            End If
        Next y
    End If
End If
Next Y
tstr$ = Mid$(tstr$, s2 + 1, Len(tstr$) - s2)

Else
    broken = True
    brokenitem = tstr$
    tstr$ = ""
End If

Loop

End Sub

Function FilterNumOfItems (ByVal tstr$) As Integer

Dim s1, s2, s3 As Integer
Dim itemnumber As String

s1 = InStr(tstr$, "matched") + 8
s2 = InStr(tstr$, "items.</h3><p>")
s3 = InStr(1, tstr$, "No", 1)

If s3 <> 0 Then
    FilterNumOfItems = 0
ElseIf s1 = 0 Or s2 = 0 Then
    FilterNumOfItems = 250
Else
    itemnumber = Mid$(tstr$, s1, s2 - 1 - s1)
    If StrComp(itemnumber, "No", 1) <> 0 Then
        FilterNumOfItems = Val(Mid$(tstr$, s1, s2 - 1 - s1))
    Else
        FilterNumOfItems = 0
    End If
End If

End Function

Sub FilterTempFile (ByVal FilePath$)

Dim tempStr As String
Dim x As Integer

If Len(Dir$(FilePath$)) > 0 Then
    Open FilePath For Input As #1

    Input #1, Header
    numberOfItems = FilterNumOfItems(Header)

    If numberOfItems = 0 Then
        NoMatched = True
        Close #1
        Exit Sub
    Else
        ReDim SearchItems(numberOfItems)
    End If

    TotalSearchItem = 0
    broken = False
    brokenitem = ""

    Do Until EOF(1)
        Input #1, tempStr
        If broken Then
MAINFORM.FRM - 3

    tempStr = brokenItem & tempStr
    broken = False
    End If
    Call FilterItems(tempStr, SearchItems(), TotalSearchItem)
    Loop
    Close #1
    Else
    Exit Sub
    End If
    End Sub

Function FormatKeyword (tstr As String) As String

Dim s1, s2, x As Integer
Dim TempKeyword As String

'Replace "+" in Keyword with ""
For x = 1 To Len(tstr)
    If (StrComp(Mid$(tstr, x, 1), "+") = 0) Then
        Mid$(tstr, x, 1) = ""
    End If
Next x

'Replace white space in Keyword with ";"
    s1 = InStr(tstr, " ")
    If s1 = 0 Then
        FormatKeyword = tstr
    Else
        TempKeyword = Mid$(tstr, 1, s1 - 1)
        s1 = s1 + 1
        's2 = s1
        Do While s1 < Len(tstr)
            s2 = InStr(s1, tstr, " ")
            If s2 = 0 Then
                FormatKeyword = TempKeyword & ";" & Mid$(tstr, s1)
                Exit Function
            Else
                TempKeyword = TempKeyword & ";" & Mid$(tstr, s1, s2 - s1)
                s1 = s2 + 1
                FormatKeyword = TempKeyword
            End If
        Loop
    End If
End Function

Sub GetSearchItem (searchkey As String, operation As String)

On Error GoTo ErrorHandling1:
    ipport1.EOL = Chr$(10)
    'close old connection - if any
    ipport1.Connected = False
    If HostOption = "HostName" Then
        ipport1.HostName = HostName
        If StrComp(HostName, "www.occ.com", 1) <> 0 Then
            ErrorHandling1:
            On Error Resume Next
MAINFOM.FRM - 4

    MsgBox "This searching site does not work. Please try the site: Online Career Center!", 16, "Error"
    Exit Sub
    End If
Else
    ipport1.HostAddress = HostAddr
End If

ipport1.Port = PortNumber

' ask for connection
ipport1.Connected = True

' wait until it is achieved
Do Until ipport1.Connected: DoEvents: Loop

' send data
OutputStart = False.

    ipport1.DataToSend = "GET " & DBSearchFile & ":and:" & operation & ":" & searchkey & Chr$(10)
    Exit Sub

ErrorHandling1:
    mainform.MousePointer = 0
    MsgBox "Error!! " & Error$ 
ipport1.Connected = False
    Exit Sub
End Sub

Sub writeHeader ()

    Open DataFileName For Append As #1

    ' Write #1, "With search criteria of (" & KeywordBox.Text & "), your query matched " & Str$(numberOfItems) & " items."
    Write #1, Header
    Close #1
End Sub

Sub writeSubHeader (index As Integer)

    Open DataFileName For Append As #1

    Write #1, String$(70, "+")
    Write #1, "Item " & Str$(index)
    Write #1, String$(70, "+")

    Close #1
End Sub

Sub BrowseBtn_Click ()

    ' Set the dialog properties
MAINFORM.FRM - 5

FileStreamDialog.DefaultExt = "DAT"
FileStreamDialog.Filter = "Job Data Files(*.DAT)|*.DAT | All Files(*.*)|*.*"
FileStreamDialog.Flags = OFN_PATHMUSTEXIST Or OFN_OVERWRITEPROMPT 'Or OFN_SHOW
HELP

'Access the Save As dialog box
FileStreamDialog.Action = 2

'Store the filename to a variable
If Err = 32755 Then 'cancel is selected
Exit Sub
Else
   DataFileName = LCase$(FileStreamDialog.Filename)
   filenamebox.Text = DataFileName
End If

End Sub

Sub CommitBtn_Click ()

Dim formKeyword As String

'check keyword is not empty, the file path is valid, then connect to the server
If Trim$(KeywordBox.Text) = "" Then
   MsgBox "Please enter searching keyword!", 16, "Error"
   Exit Sub
ElseIf Len(Dir$(GetPath(filenamebox.Text))) <= 0 Then
   MsgBox "Invalid file path to save the job information!", 16, "Error"
   Exit Sub
Else
   'get the file name to save the job information
   DataFileName = Trim$(LCase$(filenamebox.Text))

   'get the keyword to search
   Keyword = Trim$(LCase$(KeywordBox.Text))
   formKeyword = FormatKeyword(Keyword)  'replace space, and +

   maininform.WindowState = 1  'minimize the window
   NoMatched = False
   maininform.Caption = "Working on Job Searching"

   'set initial searching state
   searchdone = False
   dosearchitem = False
   SearchFinished = False

   'closeOpenedfile

   'clear two files, and ready to write information
   Open TempFileName For Output As #1
   Close #1

   Open DataFileName For Output As #1
   Close #1

   'start the timer
   Timer1.Enabled = True

   'set mousepointer to glasshour shape
MAINFORM.FRM - 6

mainform.MousePointer = 11

'connect to the host, and send request
Call GetSearchItem(formKeyword, "key")

End If
End Sub

Sub ExitBtn_Click ()

'closeOpenedfile
'import1.Connected = False

End
End Sub

Sub FileNameBox_GotFocus ()

filenamebox.SelStart = 0
filenamebox.SelLength = Len(filenamebox.Text)

End Sub

Sub Form_Load ()

formfeed = Chr$(35) & Chr$(33)
linefeed = Chr$(10) & Chr$(13)

'load the file path to retrieve search sites, and save job information
LoadFileOptions

'load the DBSite() data structure from the external file
LoadDBFile

DBSiteBackFile = GetPath(DBSiteFile) & "dbsite.bak"
'stop the timer
Timer1.Enabled = False
SearchIndex = 999

'initial the site combo list, and text boxes
If SiteCombo.ListCount > 0 Then
    SiteCombo.ListIndex = 0
End If

KeywordBox.Text = Keyword
filenameBox.Text = DataFileName

End Sub

Sub Form_Resize ()

'finishing one searching task, ready for next work
If SearchFinished Then
    mainform.Caption = "Keywords Searching All Jobs"
End If

End Sub

Sub HelpBtn_Click ()
MainForm.frm - 7

KeyHelpForm.Show 1
End Sub

Sub IPPort1_Connected (StatusCode As Integer, Description As String)
If Description <> "OK" Then
  MsgBox "Connection error: " & Description
End If

End Sub

Sub IPPort1_DataIn (Text As String, EOL As Integer)
'filter empty line
If StrComp(Text, 
""") = 0 Then
  Exit Sub
End If

If OutputStart Then 'start to download
  If Not searchdone Then 'keyword searching
    Open TempFileName For Append As 
    #1
    Write #1, Text
    Close #1
  Else 'item searching
    Open DataFileName For Append As 
    #1
    Write #1, Text
    Close #1
  End If
End If

'set download to start
If (InStr(Text, 
"</center>")) <> 0 And (OutputStart = False) Then
  OutputStart = True
End If

End Sub

Sub IPPort1_Disconnected (StatusCode As Integer, Description As String)
If Description <> "OK" Then
  MsgBox "Connection broken: " & Description
End If

'keyword searching done, parse tempfile to search job items
If Not searchdone = True Then
  searchdone = True
  Searchindex = 0
  FilterTempFile (TempFileName)

  'write header on the output file
  writeHeader

  'change caption
  mainForm.Caption = "Retrieving " & TotalSearchItem & " Matched Job Information." 'if window is minimized
End If

If searchdone Then 'keyword search done
  If NoMatched Then

MAINFORM.FRM - 8

    mainform.MousePointer = 0          'set mousepointer to normal
    If mainform.WindowState = 1 Then
        mainform.Caption = "Job Searching done. No matches!"    'if window is minimized
    End If
    If Len(Dir$(TempFileName)) > 0 Then
        Kill TempFileName
    End If
    Timer1.Enabled = False
    SearchFinished = True              'one session searching done
    Exit Sub
End If

    If SearchIndex = TotalSearchItem Then   'item search done
        mainform.MousePointer = 0          'set mousepointer to normal
        If mainform.WindowState = 1 Then
            mainform.Caption = "Job Searching done. " & TotalSearchItem & " matched job items."    'if window is minimized
        Else
            mainform.Caption = "Keywords Searching All Jobs"    'if window is normal size
        End If
    End If
    If Len(Dir$(TempFileName)) > 0 Then
        Kill TempFileName
    End If
    SearchFinished = True              'one session searching done
    Else
        SearchIndex = SearchIndex + 1   'count item index
dosearchitem = True                'start searching item
        writeSubHeader (Searchindex)
        mainform.Caption = "Retrieving " & SearchIndex & " of " & TotalSearchItem & " Matched job items."    'if window is minimized
    End If
End If
End Sub

Sub KeywordBox_GotFocus ()
    KeywordBox.SelStart = 0
    KeywordBox.SelLength = Len(KeywordBox.Text)
End Sub

Sub mnuAbout_Click ()
    AboutForm.Show 1
End Sub

Sub mnuAddSite_Click ()
    AddSiteForm.Show 1
End Sub
Sub mnuDeleteSite_Click ()
    Dim x As Integer

    'clear the list box
    DelSiteForm.SiteList.Clear

    'reload the sites
    For x = 1 To NumberOfSites
        DelSiteForm.SiteList.AddItem siteDB(x, 1)
    Next x

    'set initial selection
    DelSiteForm.SiteList.ListIndex = 0

    'show the form
    DelSiteForm.Show 1
End Sub

Sub mnuExit_Click ()
    'closeOpenedfile
    'Ipport1.Connected = False
End
End Sub

Sub mnuFileOpt_Click ()
    'set initial value
    FileOptForm.SiteDBBox.Text = DBSiteFile
    FileOptForm.JobDataBox.Text = DataFileName

    FileOptForm.Show 1
End Sub

Sub mnuSaveOpt_Click ()
    SaveFileOptions
End Sub

Sub SaveKeyBtn_Click ()
    Dim x, y As Integer

    'check the keyword box not empty
    If Trim$(KeywordBox.Text) = "$" Then
        MsgBox "Please enter searching keyword!", 16, "Error"
        Exit Sub
    Else
        Keyword = LCase$(Trim$(KeywordBox.Text))
    End If

    'change and save the search keyword for the specific searching site
    If Len(Dir(DBSiteFile)) > 0 Then
        'save the original DBSiteFile
        FileCopy DBSiteFile, DBSiteBackFile
Open DBSiteFile For Output As $1
Write $1, NumberOfSites

For x = 1 To NumberOfSites
    If siteDB(x, 1) = SiteCombo.Text Then
        siteDB(x, 6) = Keyword
    End If

    For Y = 1 To 6
        Write $1, siteDB(x, Y)
    Next Y
Next x

Close $1
Else
    MsgBox "Cannot find the site database file! Please specify the file path in the Options menu.", 16, "Error"
End If

End Sub

Sub SiteCombo_Click ()
    Dim x As Integer

    ' change the host, and the search keyword
    For x = 1 To NumberOfSites
        If siteDB(x, 1) = SiteCombo.Text Then
            KeywordBox.Text = siteDB(x, 6)
            If siteDB(x, 2) = "HostName" Then
                HostName = siteDB(x, 3)
            Else
                HostAddr = siteDB(x, 3)
                PortNumber = siteDB(x, 4)
                DBSearchFile = siteDB(x, 5)
            End If
        End If
    Next x

End Sub

Sub StopBtn_Click ()

    ' closeOpenedfile
    ' ipport1. Connected = False

    mainform.Caption = "Keywords Searching All Jobs"

    mainform.MousePointer = 0
    ' set mousepointer to normal

    If Len(Dir$(TempFileName)) > 0 Then
        Kill TempFileName
    End If

    Timer1.Enabled = False
    SearchFinished = True
    ' one session searching done

End Sub
Sub Timer1_Timer()
    ' if ready to search item, then link to the host, and send request
    If (searchdone And dosearchitem) Then
        Call GetSearchItem(SearchItems(Searchindex), "get")
        dosearchitem = False
    End If

    ' after finish item search, stop the timer
    If Searchindex = TotalSearchItem Then
        Timer1.Enabled = False
    End If
End Sub
Option Explicit

Dim NewSite(6) As String

Sub clearForm ()
    HostTitleBox.Text = ""
    HostNameBox.Text = ""
    HostAddrBox.Text = ""
    PortNumbBox.Text = "80"
    DBBox.Text = ""
    KeywordBox.Text = ""
End Sub

Sub SaveDBFile ()
    Dim x, y As Integer
    If Len(Dir(DBSiteFile)) > 0 Then
        'save the original DBSiteFile
        FileCopy DBSiteFile, DBSiteBackFile

        Open DBSiteFile For Output As #1
        Write #1, NumberOfSites

        For x = 1 To NumberOfSites - 1
            For y = 1 To 6
                Write #1, SiteDB(x, y)
            Next y
        Next x

        For x = 1 To 6
            Write #1, NewSite(x)
        Next x

        Close #1
    Else
        MsgBox "Cannot find the site database file! Please specify the file path in the Options menu.", 16, "Error"
    End If

    LoadDBFile
End Sub

Sub ApplyBtn_Click ()

    'make sure the site title is not empty
    If Trim$(HostTitleBox.Text) <> "" Then

        AddSiteForm.Hide

        NewSite(1) = HostTitleBox.Text
        If HostNameOpt.Value = True Then
            NewSite(2) = HostName
            NewSite(3) = HostNameBox.Text
            Else
                NewSite(2) = HostAddr
                NewSite(3) = HostAddrBox.Text
            End If
        NewSite(4) = PortNumbBox.Text
        NewSite(5) = DBBox.Text
    End If

End Sub
ADDSITE.FRM - 2

    NewSite(6) = KeywordBox.Text
    NumberOfSites = NumberOfSites + 1
    SaveDBFile
    clearForm

End If
End Sub

Sub CancelBtn_Click ()
    AddSiteForm.Hide
    clearForm
End Sub

Sub Form_Load ()
    'set initial state
    HostNameOpt.Value = True
    HostAddrOpt.Value = False
    HostNameBox.Enabled = True
    HostAddrBox.Enabled = False
End Sub

Sub HelpBtn_Click ()
    HelpForm.Show 1
End Sub

Sub HostAddrOpt_Click (Value As Integer)
    HostAddrBox.Enabled = True
    HostNameBox.Text = ""
    HostNameBox.Enabled = False
    HostAddrBox.SetFocus
End Sub

Sub HostNameOpt_Click (Value As Integer)
    HostAddrBox.Enabled = False
    HostNameBox.Enabled = True
    HostAddrBox.Text = ""
    HostNameBox.SetFocus
End Sub
Option Explicit

Dim DelSitesNumb As Integer
Dim DelSites() As String

Sub SaveDBFile()

Dim x, y, z As Integer
Dim SiteDeleted As Integer

If Len(Dir(DBSiteFile)) > 0 Then
    'save the original DBSiteFile
    FileCopy DBSiteFile, DBSiteBackFile

    Open DBSiteFile For Output As 

        Write 
        SiteDeleted = False

        For x = 1 To NumberOfSites + DelSitesNumb
            For y = 1 To DelSitesNumb
                If SiteDB(x, 1) = DelSites(y) Then
                    SiteDeleted = True
                End If
            Next y

            If Not SiteDeleted Then
                For z = 1 To 6
                    Write 
                    Write SiteDB(x, z)
                Next z
            End If
        Next x

    Close 

Else
    MsgBox "Cannot find the site database file! Please specify the file path in the Options menu.", 16, "Error"
End If

LoadDBFile

End Sub

Sub CancelBtn_Click()

DelSiteForm.Hide

End Sub

Sub DelBtn_Click()

Dim x, Response As Integer
ReDim DelSites(SiteList.ListCount) As String

DelSitesNumb = 0

'count the number of the deleted sites, and sites names
For x = 0 To SiteList.ListCount - 1
    If SiteList.Selected(x) = True Then
DELsite.frm - 2

    DelSitesNumb = DelSitesNumb + 1
    DelSites(DelSitesNumb) = SiteList.List(x)
    End If
    Next x

If DelSitesNumb <> 0 Then
    Response = MsgBox("Do you want to delete these searching sites?", 36, "Delete Searching Sites")
    If Response = 6 Then
        DelSiteForm.Hide
        NumberOfSites = NumberOfSites - DelSitesNumb
        SaveDBFile
    Else
        Exit Sub
    End If
End If

End Sub

Sub Form_Load()
    Dim x As Integer

    'load site list
    For x = 1 To NumberOfSites
        SiteList.AddItem SiteDB(x, 1)
    Next x

    'set the initial selection
    If NumberOfSites <> 0 Then
        SiteList.ListIndex = 0
    End If

End Sub
FILEOPT.FRM - 1

Option Explicit

Sub CancelBtn_Click ()
    FileOptForm.Hide
End Sub

Sub Form_Load ()
    'set the initial value
    SiteDBBox.Text = DBSiteFile
    JobDataBox.Text = DataFileName
End Sub

Sub OKBtn_Click ()

If Len(Dir$(GetPath(JobDataBox.Text))) <= 0 Then
    MsgBox "The Job Data file path is invalid!", 16, "Error"
    Exit Sub
End If

If Len(Dir$(GetPath(SiteDBBox.Text))) > 0 Then
    If Len(Dir$(SiteDBBox.Text)) > 0 Then
        FileOptForm.Hide
        DBSiteFile = Trim$(LCase$(SiteDBBox.Text))
        DataFileName = Trim$(LCase$(JobDataBox.Text))

        'mainform.FileNameBox.Text = DataFileName
        SaveFileOptions
        LoadFileOptions
        LoadDBFile
    Else
        MsgBox "Invalid file path for the Site Database file!", 16, "Error"
        Exit Sub
    End If
Else
    MsgBox "Invalid file path for the Site Database file!", 16, "Error"
    Exit Sub
End If

End Sub
KEYHELP.FRM - 1
Option Explicit
Sub OKBtn_Click ()
    KeyHelpForm.Hide
End Sub
ABOUT.FRM - 1
Option Explicit
Sub OKBtn_Click()
    AboutForm.Hide
End Sub
APPENDIX C

Listing of the Retrieved Job Information
With search criteria of chemical unix c++
Your query matched 5 items.

Item 1

Contact: Val Shipe
Phone: 602 820-8563
Fax: 602 820-8709
Business Line: Executive Recruiting Firm

Description:
Programmer/Analyst positions open in Bedford, Maine,
with development.

Qualifications:

Company:
Confidential Search International, Inc. is a large, industry
specific search firm. We specialize in recruiting
experienced management, production, administrative,
technical, and sales personnel for the Chemical, Healthcare,
Software Development, Securities, Wireless, and
Telecommunications industries. This focus helps us to
quickly identify the candidates that you are most likely to
hire, and cuts you
'training and interviewing time down to the bare
minimum. Our sole objective is to provide you with the very
best candidates on every search that we conduct.

Status: Full Time XEC
Salary: Competitive
Job Number: 651035
Location: Bedford, Maine / Milford, Ohio / California
Job Category: 08 Computers & Technology
Starting date: Immediate
Closing date: When Filled
Source: AZTUC

(c) Copyright 1995 Gonyea and Associates, Inc. All Rights
Reserved. Employers to advertise to 40 million viewers with
Help Wanted-USA, please call 813/372-1333. Job seekers,
contact the employer listed in the ad NOT Gonyea and
Associates.

To view our Help Wanted-USA ads on the Internet, please
visit our new Web site, called the Internet Career
Connection. URL to http://ocweb.com
"Item 2"

"Mastech Corporation is a leading provider of customized open systems' programming and software support services. To date, the firm has rendered to its clients over $100 million in ADP technical support services. Mastech currently employs over 1400 permanent full time software engineers, programmers, analyst, database specialists and numerous other diverse technical positions. Since the company's inception in 1986, it has seen tremendous growth successfully performing on over 300 client sites in 45 states across the U.S. including Mexico, Canada, and Asia. In first quarter of 1996, Mastech is slated to open offices in U. K. and Europe."

"Mastech was awarded IBM Supplier of the Year award two years in a row" "and is number 31 on the Fortune 500 Inc. list."

"A sampling of our client list includes but definitely not limited to:

"Johnson & Johnson"
"General Motors"
"Philip Morris"
"Dow Chemical"
"Upjohn"
"Blue Cross/Blue Shield"
"J. C. Penny Kellogg"
"Sears"
"Citibank"
"Chase Manhattan"
"Dow Jones AT & T"
"MCI"
"Major Airlines"
"EDS"
"IBM"
"TANDEM"
"UNISYS"
"Federal Agencies"
"State and Local Governments"

"Currently we have 3 requirements for a individuals with 2 YEARS ON C++, OOP"
"GURU, HP UNIX OR UNIX. DESIRED: GRADY BOOCH'S METHODOLOGY OR OMT, JACOBSON."

"These positions are located in VIRGINIA. If you have the flexibility of being mobile and are interested in great opportunities, I invite you to fax me your resume."

"Mastech has the flexibility to offer W2/hourly no benefits or to offer an individual permanent employment with salary, full benefits, and relocation assistance. What makes Mastech unique from other organizations are several factors:"

"1) If you are a permanent employee, when your project is completed you would alert Mastech as to the approximate completion date. Mastech in turn would have another project for you when you become available. Should there NOT be a project suited for you that is available, you would go on what is called"
"the Bench List. This is a listing of individuals who are available through*
"the organization. These people are still being paid their salary and*
"benefits until a project come through for them."
"2)"
"Each area of the United States has designated Personnel Managers and*
"Personnel Assistances to assist any employee with any concerns, questions, or*
"problems."
"3) Mastech has very competitive market rates and excellent benefits."
"Mastech offers its employees the following benefits:"*
"---Company paid medical and dental (Blue Cross/Blue Shield)"
"benefits with NO contribution from the employee. This is"
"provided by the Company for not only the employee, but the"
"spouse and dependants as well."
"---401k savings plan"
"---credit union"
"---long term disability and life insurance as well as AD&D"
"---vacation, holiday and sick leave"
"---membership to a nationally known health club"
"---comprehensive relocation package"
"---tuition reimbursement"
"For immediate consideration, please fax your resume to:"
"Karen L. Tynes"
"FAX: 703.204.0784"
"Mastech Corporation"
"REF: <b>C++</b>, OOP, BOOCH"
"or you may simply forward by email to:"*
"MASKLK@AOL.COM"
"REF: <b>C++</b>, OOP, BOOCH"
"Thanks !!!"
"Karen"
"</pre>"

"+++
"**Item 3**
"+++
"<hr><h5>(Match index is 13608270)</h5><p><pre>Subject : Software Design/Developer (AZ) (U/R )
"From : occ@occ.com"
"Confidential Search International, Inc."
"6115 South Kyrene Road, Suite 201"
"Tempe, Arizona 85283"
"Contact: Brian Vines"
"Phone: 602 820-8663"
"Fax: 602 820-8709"
"Business Line: Executive Recruiting Firm"
"Description:"
"Software Design-Developer position open in New Jersey."
"Excellent base salary, Annual Bonus, Stock Options, 401K,"
"Medical and Dental."
"Qualifications:"
"Strong background in <b>Unix</b>, <b>C</b>, <b>C++</b>, TCP/IP, OSI protocol and "
"CMIP desirable. OOA/OOD. Distributed Computing. 3 plus "
"years experience."
""
"Company: "
"Confidential Search International, Inc. is a large, industry specific search firm. We specialize in recruiting "
"experienced management, production, administrative, "
"technical, and sales personnel for the Chemical, Healthcare, "
"Software Development, Securities, Wireless, and "
"Telecommunications industries. This focus "
"helps us to "
"quickly identify the candidates that you are most likely to "
"hire, and cuts your interviewing time down to the bare "
"minimum. Our sole objective is to provide you with the very "
"best candidates on every search that we conduct. "
"=
"= Status: Full Time XEF "
"Salary: Competitive "
"Job Number: 651013A "
"Location: New Jersey "
"Job Category: 08 Computers & Technology "
"Starting date: Immediate "
"Closing date: When Filled "
"Source: AZTUC "
"=
"= (c) Copyright 1995 Gonyea and Associates, Inc. All Rights "
"Reserved. Employers to advertise to 40 million viewers with "
"Help Wanted-USA, please call 813/372-1333. Job seekers, "
"contact the employer listed in the ad NOT Gonyea and "
"Associates. "
"="
"To view our Help Wanted-USA ads on the Internet, please "
"visit our new Web site, called the Internet Career "
"Connection. URL to http://iccweb.com "
"="
"<pre>"
"="
"Item 4"
"="
"<hr><h5>(Match index is 30096663)<h5><p><h6>location: ontario north texas southcentral michigan midwest maine northeast boston massachusetts"
"Profile: 345212"
"Path:
dorite!news.sprintlink.net!newsfeed.internetmci.com!usenet.eel.ufl.edu!news.interlog.com!io.org!usenet"
"From: NIMALAKIRTHI <nimalak@io.org>"
"Subject: Scientific/Engineering Programmer"
"Date: 28 Oct 1995 18:28:18 GMT"
"Nimalakirthi Rajasinghe"
"  28, Frontier Parkway"
"  Scarborough"
"  Ontario M1B 4G4"
"  Tel: (416) 282-2163"
"  Oct. 21, 1995"
"Professional Staffing Manager"
"misc.jobs"
"Application for a Scientific/Engineering Programmer Position"
"Dear Sir,"
"Please find enclosed my resume for scientific/engineering programmer "
"position. I have been working with Prof. K. L. C. Hunt for my Ph. D."
"(computational Chemistry) on Plasma Excitations and Polarizability"
"Densities. I analyzed and computed these properties for an electron"
"gas and atomic systems. Two manuscripts based on my Ph. D. research"
"have been published and"
"a third is in preparation. I was awarded"
"the Robert A. Welch Fellowship from Texas A&M University. During"
"this period I developed large scale computer programs in <b>UNIX</b>"
"environment for materials science and metallurgy research."
"During my study period for my <b>Chemical</b> Engineering degree at"
"Michigan State University, I developed a continuous simulation"
"method for polymer network formation. I have experience in numerical"
"modelling and simulations for process design and control. I have"
"completed more than 112 graduate semester credits from Michigan"
"State University which includes 30 class credits of graduate physics"
", 25 class credits of graduate <b>Chemical</b> engineering and 20 class"
"credits of graduate chemistry classes."
"During my study period for my Physics degree at Michigan State"
"University, I have gained strong mathematical and computational"
"skills, relevant to physical science and engineering research and"
"development. I have experience in using SUN and HP work stations,"
"and IBM PC's. During my study period at Northeastern University I"
"worked with a theoretical chemist and studied theoretical and"
"computational methods in fluid mechanics research. I have"
"experience in developing research software in FORTRAN/C and <b>C++</b>. I"
"have completed 4 parts of NetWare Engineering examinations and have"
"experience in DOS/UNIX operating systems and PC Network"
"administration."
"My diversified background"
"in physical sciences and engineering will"
"help me to serve you as a scientific/engineering programmer. If you"
"need any further information I will be glad to provide it upon your"
"request. I am looking forward to hearing from you. Thank you."
"Sincerely,
"Nimalakirthi"
"Nimal Rajasinghe"
"28, Frontier Pathway"
"Scarborough, Ontario M1B 4G4"
"Tel: (416) 282-2163"
"Education"
"Michigan State University"
"Michigan"
"M. S. in <b>Chemical</b> Engineering May 1995"
"Michigan State University"
"Michigan"
"Ph. D. in Computational Chemistry May 1993"
"Michigan State University"
"Michigan"
"M. S. in Physics May 1990"
"University of Colombo"
"Sri Lanka"
"B. S. in Chemistry Dec. 1982"
"Professional Experience"
"Research Assistant"
"Michigan State University"
Department of Chemical Engineering  June 93 - May 95

Thesis Title: A Continuous Monte Carlo Method for Simultaneous Growth and Equilibration in Gelation.

Research: A continuous simulation method for polymer network formation in the presence of cross-linking agents was developed and its com

putational feasibility was studied by

Monte Carlo simulations.

Research Scientist

Texas A&M University

Department of Chemistry  Jan. 92 - June 93

Research: Numerical algorithms and scientific software was developed for materials science research.

Research Assistant

Michigan State University

Department of Chemistry  Sep. 87 - Dec. 91

Thesis Title: Linear response functions of an interacting Fermi gas at zero temperature.

Research: The response of an interacting electron gas to weak external electromagnetic fields was computationally analyzed. New expressions for frequency dependent polarizability density was derived, and new results for the plasma magnetic susceptibility was computed. New results for the interpretation of vibrational Raman band intensities with a connection to nonlinear optical properties was computationally analyzed.

Research Assistant

Northeastern University

Boston, Massachusetts

Department of Chemistry  Jan. 85 - Aug. 87

Research: Computational fluid mechanics research.

Assistant Scientist

Government Analyst's Department

Sri Lanka  Jan. 83 - Dec. 84

Work: Computational scientist, programmer/analyst.

Technical Experience

Certified NetWare Administrator

Special Skills

Computer simulations, scientific software development and mathematical m

odeling. Strong C++ and FORTRAN programming.

skills.

Fellowships

Robert A. Welch Fellow

Texas A&M University, 1992

References

Available upon request.

Item 5
"hr"<h5>(Match index is 34395011)</h5><p>Profile: 331608"</p>"Path:
dorimednews.sprintlink.net\newsfeed.internetnewsl\toronto.fonorola.net\kowloon.terraport.net\archangel.terraport.net\news"  
"From: isg@terraport.net (ISG Informatics Search Group)"
"Subject: Various Permanent Positions in the Greater Toronto Area from ISG"
"Date: Sun, 15 Oct 1995 16:55:31 GMT"
"**** ISG - Informatics Search Group ****"
"The number one I.T. search firm in the"
"Greater Toronto Area"  
"NOTES"
"If you have developed several complex applications in LOTUS NOTES in"
"Large Groupware environments, more than 3 years industry experience"
"developing solutions, and a Technology degree let's talk!"
"George AGAR, Ext. 234"
"OS/2 <b>C++</b>"  
"Our client is looking for an OS/2 PM GURU who has moved Applications"
"written in <b>C++</b> from a WINDOWS MFC platform. Experience with"
"equivalent functions in Windows MFC and OS/2 PM is very important to"
"the project."
"George AGAR, Ext. 234"
"C++/C"  
"If you have 3 + y"
"ears of C/C++ on Windows using either OWL or MFC,"
"working knowledge of API Programming, and a Computer Science or"
"Electrical Engineering degree, our client is interested in discussing"
"a dynamic opportunity."
"George AGAR, Ext. 234"
"SYSTEMS ANALYST"
"Strong knowledge of systems analysis methodologies and techniques"
"(e.g. JAD/JAR/RAD) plus exp. with various technologies including"
"Relational Databases are required"
"to design & implement fully integrated packages for our client."
"Sean Ford, Ext. 251"
"TECHNICAL ARCHITECT"
"Architect & design technical implementation of applications for our"
"client. Your 6+ years of industry related exp. including exp. with"
"mainframes and <b>UNIX</b> is enhanced by a working knowledge of RDBMs."
"Experience with WINDOWS GUI design is essential."
"DAN GROMMOL, Ext. 230"
"ORACLE DBA"
"Our client, a major retailer is currently seeking the services of a"
"Senior Oracle DBA. Responsibilities will include developing database"
"strategies and guidelines, leading the database technical evaluation"
"and overall direction plus database design activities."
"Ken MANN, Ext. 225"
"TANDEM PROGRAMMERS"
"We have several mandates for Tandum programmer/analysts with strong"
"Cobol, Tal, Pathway and C. Asset skills would be one or more of the"
"following: TCP/IP, X.25, LANS and ODBC. If you have any Tandum skills"
"at all, please apply."
"Ken MANN, Ext. 225"
"<b>UNIX</b> SOFTWARE ENGINEERS."
"We have immediate openings within the downtown core "
"and also north of"
"the city for experienced <b>Unix</b>, C developers. Any exposure to Sco-Unix"  
together with porting experience from Dos to <b>Unix</b> would prove to be an  
asset.

KEN MANN, Ext. 225

"SYSTEMS PROGRAMMER"
"Solid experience with ADX, OS/2, and SOM/DSOM is required."
"Knowledge of SQL or other major RDBMS and a strong understanding of"  
distributed systems(DCE) is a plus."  
"Downtown location."

LOU BENNETT, Ext. 236

"SYSTEMS SOFTWARE DEVELOPER"
"Capable software developer required to work within <b>UNIX</b>  
"and TCP/IP. Work is at the socket level designing system"  
"software for security access purposes. Required skills are:"  
"C, TCP/IP, and encryption experience. Downtown."

LOU BENNETT, Ext. 236

"SOFTWARE DEVELOPERS"
"Junior and intermediate level SMALLTALK developers required."
"Minimum six months SMALLTALK/V experience(can be academic), and OS/2"  
exposure. Banking or finance experience would be an asset. Downtown"  
"location."

LOU BENNETT, Ext. 236

"PROGRESS-PJT MGR"
"This well known Canadian company is embarking on an ambitious growth"  
"phase and requires a capable I.T. Professional who is ready to vault"  
"to the next level. Combine PROGRESS development skills proven"  
"Analytical and Project Management abilities. Mississauga."

PETER BAXTER, Ext. 223

"ODBC-SFTWE DEVELOPERS"
"Several openings for Degreed Software Professionals with WINDOWS NT/95"  "& VISUAL <b>C++</b> development experience. Open to Junior & Senior levels"  
"with preference given to those with ODBC skills. A world renown vendor"  
"generous bonus plan."

PETER BAXTER, Ext. 223

"TECH/SUPPORT ANALYST"
"Immediate requirement for a PC Support/Help Desk individual - with a"  
"minimum of 2 years experience. Your background should include solid"  
"knowledge in MICROSOFT products and NOVELL. Be involved in"  
"installation, configuration & user support, etc."  

LISA PALLOTTA, Ext 228

"BUSINESS ANALYST"
"This intermediate position will involve technical & procedural support"  
to all users of this company's software applications coupled with"  
testing all new, enh"  
anced and modified applications prior to release."  
"Previous AS/400 experience is beneficial.  

LISA PALLOTTA, Ext 228

"AS/400 SECURITY OFFICER"
"This hands-on role requires indepth knowledge of AS/400 & OS/400. You"  
"will be the most senior person in this department"  
"supervising 2 computer operators as well as implementing a"
"software package called MIMICS. Ottawa location"

KEVIN GOLDEN, Ext. 238
"AS/400 CONSULTANTS"
"Your superb interpersonal and communication skills combined with a
"minimum of 2+ years of RPG programming experience will allow you to
"venture into the consulting world opening up several
"doors for the future."
" SEAN FORD, Ext. 251"
"SR PRE-SALES-OTTAWA"
"Join a giant in the vendor community providing technical sales"
"assistance to major clients. Your superb client skills, strong"
"knowledge of CLIENT/SERVER, RDBMS, <b>UNIX</b> & familiarity with large"
"applications is needed. $70-90k plus incentives."
" FRANK VRABEL, Ext. 250"
"OS/2 PM & "C"
"DEVELOPERS - all levels. Join an international provider of mission"
"& advancement. Minimum 1 yr OS/2, PRESENTATION MANAGER & "C" required."
" FRANK VRABEL, EXT. 250"
"INTERNET/UNIX"
"Administrators with strong <b>UNIX</b> and INTERNET experience required for"
"this emerging technologies firm. Individual will possess knowledge of"
"TCP/IP including configurations and testing. Will also be a mentor to"
"junior staff."
" PATRICK HYLTON, EXT. 222"
"INSURANCE P/A’s"
"Insurance firm requires Programmer Analysts with COBOL, CICS and"
"Personal Lines Insurance Systems. Join a team on Development and"
"Maintenance Projects. Policy Management Systems a definite asset."
" PATRICK HYLTON, EXT 222"
"VISUAL BASIC, ACCESS, WINDOWS"
"This is primarily a SYSTEMS ANALYST’s role with some programming"
"calling for the above skills. You will be familiar with various"
"methodologies as well as having responsibility for projects. Corporate"
"office of high profile firm."
" MARY BRODERICK, Ext.224"
"ORACLE DBA/DE"
"VELOPER"
"You will have a combination of DBA/DEVELOPMENT on <b>UNIX</b>. Knowledge of"
"Novell, Windows NT, OS/2 and/or AS400 is very desirable as this is a"
"multiple platform high profile company. Job function will be primarily"
"that of a DBA role."
" MARY BRODERICK, Ext.224"
"GUI DEVELOPERS"
"Here is an opportunity for a strong COBOL developer who has WINDOWS"
"experience to migrate from Mainframe to Client Server!!! These two"
"skills do not necessarily have to be together."
"Challenging and interesting opportunity with great Company."
" MARY BRODERICK, Ext.224"
"SOFTWARE, T.L./P.L.'S."
"Nationally recognized organization, with leading-edge technology, is"
"offering exciting career opportunities for dynamic software developers"
"with 2 + yrs. of WINDOWS dev't. exp. using VC ++ and/or VB combined"
"with a RDBMS in <b>UNIX</b> server env't."
" JOE FARO, Ext.240"
"<b>C++</b> with XWINDOWS/MOTIF"
"Perm posns avail for P/As with <b>C++</b> in an XWINDOWS/MOTIF envt. Any"
"RDBMS (Sybase ideal) or project management skills will provide you" "with the additional skills to contribute in this high profile" "financial institution. Leck downtown." " ANDREA GUINN, x233* " "LOTUS NOTES P/As" "Thes" "e positions require a solid NOTES pgmg background combined with a" "confident business manner. You will be working in a new dev't group" "developing investment banking applications and integrating them with" "external processes/data." " ANDREA GUINN, x233* " "PLC ENGINEERS" "A "consulting type' candidate with strong oral & written skills to" "design automated process manufacturing systems using Allen Bradley" "PLCs. Comp Sc or Eng degree/diploma with 2+ years experience and" "computer systems knowledge are mandatory." " PRENTICE SMITH, Ext 235 " ""DCS* PROCESS CONTROL ENGINEERS" "A "consulting-type" to scope client requirements, customize & install" "system at petro chem, refineries, or Pulp & Paper plants. You should" "have an engineering degree, <b>chemical</b> preferred, some real time" "programming (C, Pascal or Fortran) with PID systems." " PRENTICE SMITH, Ext 235" " "OBJECT-ORIENTED DEVELOPER " "For a S/W development group using MS tools (VISUAL <b>C++</b>, MFC, WINDOWS" "NT, SQL/SERVER). You must have excellent communication skills (oral &" "written) and a Comp. Sc. or Eng. <b>UNIX</b>, LAN, GUI, and real time are" "real assets." " PRENTICE SMITH, Ext 235* " "SENIOR SOFTWARE TESTER" "QA & Testing specialist required for this newly created position. This" "company Develops advanced Video/Imaging Software products on WINDOWS" "NT & 95 using the latest in OO & GUI tools. Your mandate is to" "spearhead this new section within R&D. " " RICHARD CRAIG, Ext.227" " "VISUAL <b>C++</b> DEVELOPERS" "Thriving Software Vendor requires Visual <b>C++</b> developers. This company" "has earned a superb reputation for their products and their people." "Their doors are now open to creative software developers with Visual" "<b>C++</b> and MFC development experience." " RICHARD CRAIG, EXT.227 " " "DERIVATIVES SPECIALIST" "As the senior Business Analyst working with traders in Toronto, LA and" "New york on Systems issues related to Derivatives and the Capital" "Markets. Your role will be to interface between IS and the Traders and" "recommend business and technical solutions." " RICHARD CRAIG, EXT.227" " "PROGRESS PROGRAMMER ANALYST" "Join this exciting Canadian firm dealing with the financial services" "industry. Your proven abilities in application programming, design" "and support using Progress will open up the doors to this new" "opportunity. Downtown location." " TERESA ROTI, EXT. 226* " "SR. SYSTEM ANALYST" "Your project management experience combined with excellent user skills"
"will qualify you for this opportunity in the west end of the city."
"Strong requirements gathering and analytical skills and knowledge of"
"manufacturing applications are the keys to this opportunity."
"TERESA ROTI, EXT. 226"
"DATABASE ADMINISTRATOR"
"Strong experience in database administration, <b>unix</b> administration and"
"PC LAN to <b>Unix</b> connectivity tools are the key to this opening with a"
"financial services organization"